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Abstract 

Modelica is a modern, strongly typed, declarative, equation-based, and object-oriented lan-
guage for modeling and simulation of complex systems. Major features are: ease of use, vis-
ual design of models with combination of lego-like predefined model building blocks, ability 
to define model libraries with reusable components, support for modeling and simulation of 
complex applications involving parts from several application domains, and many more use-
ful facilities. This paper gives an overview of some aspects of the Modelica language and the 
OpenModelica environment – an open-source environment for modeling, simulation, and de-
velopment of Modelica applications.  
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1 Introduction 
A large number of modeling and simulation tools are 
available on the market. Most tools are very special-
ized and only address a specific application domain. 
These tools usually have incompatible model formats.  

However, certain tools are of a more general nature. 
For modeling and simulation of dynamic systems, we 
have e.g. the following de-facto standards: 

• Continuous: Matlab/Simulink,... [15], MatrixX/ 
SystemBuild, Scilab/Scicos, ACSL,... for general 
systems, SPICE and its derivates for electrical cir-
cuits, ADAMS, DADS/Motion, SimPack, Sim-
Mechanics,... for multi-body mechanical systems, 
ANSYS, FEMLAB, etc. for finite-element analy-
sis, ... 

• Discrete: general-purpose simulators based on the 
discrete-event GPSS line, VHDL- and Verilog 
simulators in digital electronics, etc. 

• Hybrid (discrete + continuous): Modelica, 
gPROMS [2], AnyLogic, VHDL-AMS and Ver-
ilog-AMS simulators (not only for electronics but 
also for multi-physics problems), etc. 

The insufficient power and generality of the former 
modeling languages has stimulated the development of 
Modelica (as a true object-oriented, multi-physics lan-
guage) and VHDL-AMS/Verilog-AMS (multi-physics 
but primarily for electronics, and therefore often not 
general enough). 

1.1 Modelica Background 

In 1996 several first generation object-oriented mathe-
matical modeling languages and simulation systems 
(ObjectMath [9], Dymola [6] [7], Omola [16], NMF 
[22], gPROMS [2], Allan, Smile, etc.) had been devel-
oped. 

However, the situation with a number of different in-
compatible object-oriented modeling and simulation 
languages was not satisfactory. Therefore, in the fall of 
1996, a group of researchers from universities and 
industry started work towards standardization and 
making this object-oriented modeling technology 
widely available. This language is called Modelica 
[10][17][23] and designed primarily for modeling dy-
namic behavior of engineering systems; moreover, 
meta-modeling extensions have recently being devel-
oped [11]. The language is intended to become a de 
facto standard. 

The language allows defining models in a declarative 
manner, modularly and hierarchically and combining 
various formalisms expressible in the more general 
Modelica formalism. The multidomain capability of 
Modelica allows combining electrical, mechanical, 
hydraulic, thermodynamic, etc., model components 
within the same application model.  

Compared to most widespread simulation languages 
available today this language offers several important 
advantages: 

• Object-oriented mathematical modeling. This tech-
nique makes it possible to create model compo-
nents, which are employed to support hierarchical 
structuring, reuse, and evolution of large and com-
plex models covering multiple technology do-
mains. 

• Acausal modeling. Modeling is based on equations 
instead of assignment statements as in traditional 
input/output block abstractions. Direct use of equa-
tions significantly increases re-usability of model 
components, since components adapt to the data 
flow context in which they are used. Interfacing 
with traditional software is also available in Mode-
lica. 

• Physical modeling of multiple application domains. 
Model components can correspond to physical ob-
jects in the real world, in contrast to established 
techniques that require conversion to “signal” 
blocks with fixed input/output causality. In Mode-
lica the structure of the model naturally correspond 
to the structure of the physical system in contrast to 
block-oriented modeling tools such as Simulink. 
For application engineers, such “physical” compo-
nents are particularly easy to combine into simula-
tion models using a graphical editor. 

• A general type system that unifies object-
orientation, multiple inheritance, compo-
nents/connectors, and templates/generics within a 
single class construct. 

Hierarchical system architectures can easily be de-
scribed with Modelica thanks to its powerful compo-
nent model. Components are connected via the con-
nection mechanism realized by the Modelica system, 
which can be visualized in connection diagrams. The 
component framework realizes components and con-
nections, and ensures that communication works over 
the connections.  

For systems composed of acausal components with 
behavior specified by equations, the direction of data 
flow, i.e., the causality is initially unspecified for con-
nections between those components. Instead the cau-
sality is automatically deduced by the compiler when 
needed. Components have well-defined interfaces con-
sisting of ports, also known as connectors, to the ex-
ternal world. A component may internally consist of 
other connected components, i.e., hierarchical model-
ing.. Fig. 1 shows hierarchical component-based mod-
eling of an industry robot. 
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Fig. 1. Hierarchical model of an industrial robot, 

including components such as motors, bearings, control 
software, etc. At the lowest (class) level, equations are 

typically found. 

The language design and model library development 
has proceeded through a number of design meetings 
(the 52:th May 2007), a nonprofit Modelica Associa-
tion was started in Linköping, Sweden year 2000, and 
a conference series was started the same year, with the 
5th conference in Vienna Sept. 2006. Several commer-
cial implementations of Modelica (i.e., subsets thereof) 
are available, including Dymola [5], MathModelica 
[14], and IDA [3]. This paper primarily focuses on the 
OpenModelica, which currently is the major Modelica 
open-source tool effort. 

2 The OpenModelica Environment 
The OpenModelica environment described in this pa-
per has several goals, including, but not limited to the 
following: 

• Providing an efficient interactive computational 
environment for the Modelica language.  

• Development of a complete reference implementa-
tion of Modelica in an extended version of Mode-
lica itself. 

• Providing an environment for teaching modeling 
and simulation. It turns out that with support of ap-
propriate tools and libraries, Modelica is very well 
suited as a computational language for develop-
ment and execution of both low level and high 
level numerical algorithms, e.g. for control system 
design, solving nonlinear equation systems, or to 
develop optimization algorithms for complex ap-
plications. 

• Language design, e.g. to further extend the scope 
of the language, e.g. for use in diagnosis, structural 
analysis, system identification, etc., as well as 
modeling problems that require extensions such as 
partial differential equations, enlarged scope for 
discrete modeling and simulation, etc. 

• Language design to improve abstract properties 
such as expressiveness, orthogonality, declarativ-
ity, reuse, configurability, architectural properties, 
etc. 

• Improved implementation techniques, e.g. to en-
hance the performance of compiled Modelica code 
by generating code for parallel hardware. 

• Improved debugging support for equation based 
languages such as Modelica, for improved ease of 
use. 

• Easy-to-use specialized high-level (graphical) user 
interfaces for certain application domains. 

• Visualization and animation techniques for inter-
pretation and presentation of results. 

• Application usage and model library development 
by researchers in various application areas. 

In this paper we briefly present a few of the subsys-
tems, as well as some architectural aspects of the envi-
ronment. Further, we will give examples of the usage 
of the interactive session handler, the DrModelica 
notebook, and the debugging support. 

2.1 Environment Overview 

The OpenModelica environment consists of several 
interconnected subsystems, as depicted in Fig. 2. 
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Fig. 2.  The architecture of the OpenModelica 
environment.  

Arrows denote data and control flow. Several subsys-
tems provide different forms of browsing and textual 
editing of Modelica code. The debugger currently pro-
vides debugging of an extended algorithmic subset of 
Modelica. The graphical model editor is not really part 
of OpenModelica but integrated into the system and 
available from MathCore [14] without cost for aca-
demic usage. The following subsystems are currently 
integrated in the OpenModelica environment:  

• An interactive session handler, that parses and in-
terprets commands and Modelica expressions for 
evaluation, simulation, plotting, etc. The session 
handler also contains simple history facilities, and 
completion of file names and certain identifiers in 
commands.  

• A Modelica compiler subsystem, translating Mode-
lica to C code, with a symbol table containing defi-
nitions of classes, functions, and variables. Such 
definitions can be predefined, user-defined, or ob-
tained from libraries. The compiler also includes a 
Modelica interpreter for interactive usage and con-
stant expression evaluation. The subsystem also in-
cludes facilities for building simulation executables 
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linked with selected numerical ODE or DAE 
solvers. 

• An execution and run-time module. This module 
currently executes compiled binary code from 
translated expressions and functions, as well as 
simulation code from equation based models, 
linked with numerical solvers. Limited event han-
dling facilities are included for the discrete and hy-
brid parts of the Modelica language. 

• Emacs textual model editor/browser. In principle 
any text editor could be used. We have so far pri-
marily employed Gnu Emacs, which has the advan-
tage of being programmable for future extensions. 
A Gnu Emacs mode for Modelica has previously 
been developed. The Emacs mode hides Modelica 
graphical annotations during editing, which other-
wise clutters the code and makes it hard to read. 
The Emacs mode has been largely superceeded by 
the Eclipse plugin described below. 

• Eclipse plugin editor/browser/compilation man-
ager. The Eclipse plugin [21] provides file and 
class hierarchy browsing and text editing capabili-
ties. Some syntax highlighting facilities are also in-
cluded. The Eclipse framework has the advantage 
of making it easier to add future extensions such as 
refactoring and cross referencing support. A com-
pilation manager is also included. Automatic in-
dentation and debugging facilities are recently be-
ing added [20]. 

• DrModelica notebook textual model editor. This 
subsystem provides a lightweight notebook editor, 
compared to the more advanced Mathematica 
notebooks available in MathModelica. This basic 
functionality still allows essentially the whole 
DrModelica tutorial to be handled. Hierarchical 
text documents with chapters and sections can be 
represented and edited, including basic formatting. 
Cells can contain ordinary text, graphics, or Mode-
lica models and expressions, which can be evalu-
ated and simulated. However, no mathematical 
typesetting facilities are yet available in the cells of 
this notebook editor. 

• Graphical model editor/browser. This is a graphi-
cal connection editor, for component based model 
design by connecting instances of Modelica 
classes, and browsing Modelica model libraries for 
reading and picking component models. The 
graphic model editor is not really part of Open-
Modelica but a MathModelica Lite version of the 
editor, see Section 9, is integrated with the system 
and provided by MathCore AB [14] without cost 
for academic usage. The graphic model editor also 
includes a textual editor for editing model class 
definitions, and a window for interactive Modelica 
command evaluation. 

• Modelica debugger. The current implementation of 
the debugger [18] provides debugging for an ex-
tended algorithmic subset of Modelica, excluding 
equation-based models and some other features, 
but including some meta-programming and model 

transformation extensions [11] to Modelica. This is 
conventional full-feature debugger, using Emacs 
for displaying the source code during stepping, set-
ting breakpoints, etc. Various back-trace and in-
spection commands are available. The debugger 
also includes a data-view browser for browsing hi-
erarchical data such as tree- or list structures in ex-
tended Modelica. As just mentioned, this debugger 
has been integrated in the OpenModelica Eclipse 
plugin. 

2.2 Implementation Status 

The current version of the OpenModelica environment  
(June 2007) allows most of the expression, equation, 
algorithm, and function parts of Modelica to be exe-
cuted interactively, as well as to being compiled into 
efficient C code. The generated C code is combined 
with a library of utility functions, a run-time library, 
and a numerical DAE solver. An external function 
numeric library interfacing a LAPACK subset and 
other basic algorithms has also recently been devel-
oped. 

Not all subsystems are yet integrated as well as is indi-
cated in Fig. 3. Currently there are two versions of the 
Modelica compiler, one which supports most of stan-
dard Modelica including simulation, and is connected 
to the interactive session handler, the notebook editor, 
and the graphic model editor, and another meta-
programming Modelica compiler version which is 
integrated with the debugger and Emacs, supports 
meta-programming Modelica extensions [11], but does 
not allow equation-based modeling and simulation. 
Those two versions are currently being merged into a 
single OpenModelica compiler version. 

3 The OpenModelica Client-Server Ar-
chitecture 

The OpenModelica client-server architecture is sche-
matically depicted in Fig. 3, showing three typical 
clients. 
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Fig. 3.  Client-Server interconnection structure of the 
compiler/interpreter main program and interactive tool 

interfaces. 
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The three clients are: a graphic model editor, an inter-
active session handler for command interpretation, and 
the MDT Eclipse plugin. 

Commands or Modelica expressions are sent as text 
from the clients via the CORBA interface, parsed, and 
divided into two groups by the main program: 

• All kinds of declarations of classes, types, func-
tions, constants, etc., as well as equations and as-
signment statements. Moreover, function calls to 
the untyped API also belong to this group – a func-
tion name is checked if it belongs to the API 
names. The Interactive module handles this 
group of declarations and untyped API commands. 

• Expressions and type checked API commands, 
which are handled by the Ceval module. 

The reason the untyped API calls are not passed via 
SCode (a module generating an intermediate form of 
the abstract syntax tree) and Inst (which performs 
symbolic instantiation of components) to Ceval is that 
Ceval can only handle typed calls – the type is always 
computed and checked, whereas the untyped API pri-
oritizes performance and typing flexibility. The Main 
module checks the name of a called function name to 
determine if it belongs to the untyped API, and should 
be routed to Interactive. 

Moreover, the Interactive module maintains an 
environment of all interactively given declarations and 
assignments at the top-level, which is the reason such 
items need to be handled by the Interactive mod-
ule. 

4 Simplified Overall Structure of the 
Compiler 

The OpenModelica compiler is divided into a number 
of modules, to separate different stages of the transla-
tion, and to make it more manageable. The top level 
function is called main, and appears as follows in sim-
plified form that emits flat Modelica (leaving out the 
code generation and symbolic equation manipulation): 
function main 
  input String f  "file name"; 
protected 
  Absyn  ast; 
  SCode  scode1; 
  SCode  scode2; 
algorithm 
  ast := Parser.parse(f); 
  scode1 := SCode.elaborate(ast); 
  scode2 := Inst.elaborate(scode1); 
  DAE.dump(scode2); 
end main; 

The simplified overall structure of the OpenModelica 
compiler is depicted in Fig. 4, showing the most im-
portant modules, some of which can be recognized 
from the above main function. The total system con-
tains approximately 40 modules. 
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Fig. 4.  The OpenModelica compiler (omc) decomposed 
into modules and data flow connections.  

The parser generates abstract syntax (Absyn) which is 
converted to the simplified (SCode) intermediate form. 
The code instantiation module (Inst) calls Lookup to 
find a name in an environment. It also generates the 
DAE equation representation which is simplified by 
DAELow. The Ceval module performs compile-time or 
interactive expression evaluation and returns values. 
The Static module performs static semantics and 
type checking. The DAELow module performs BLT 
sorting and index reduction (see Chapter 18 in [10]). 
The DAE module internally uses Exp.Exp, 
Types.Type and Algorithm.Algorithm; the 
SCode module internally uses Absyn. 

5 Interactive Session with Examples 
The following is an interactive session using the inter-
active session handler in the OpenModelica environ-
ment. (Called OMShell – the OpenModelica Shell).  

The Windows version which at installation is made 
available in the start menu as OpenModelica-

>OpenModelica Shell responds with an interaction 
window shown in Fig. 5. 

 

 
Fig. 5.  Initial screen of the interactive session handler. 

We enter an assignment of a vector expression, created 
by the range construction expression 1:12, to be 
stored in the variable x. The value of the expression is 
returned. 
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>> x := 1:12 
 {1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 11, 12} 

Look at the type of x: 

>> typeOf(x) 
"Integer[]" 

The function bubblesort is called to sort this vector 
in descending order. The sorted result is returned to-
gether with its type. Note that the result vector is of 
type Real[:], instantiated as Real[12], since this is 
the declared type of the function result. The input In-
teger vector was automatically converted to a Real 
vector according to the Modelica type coercion rules. 
The function is automatically compiled when called if 
this has not been done before. 

>> bubblesort(x) 
{12, 11, 10, 9, 8, 7, 6, 5, 4, 3, 2, 1} 

It is also possible to give operating system commands 
via the system utility function. A command is pro-
vided as a string argument. The example below shows 
the system utility applied to the UNIX command cat, 
which here outputs the contents of the file bubble-
sort.mo to the output stream. However, the cat com-
mand does not boldface Modelica keywords – this 
improvement has been done by hand for readability. 

>> cd("C:/OpenModelica1.4.0/testmodels") 
>> system("cat bubblesort.mo") 

function bubblesort 
  input Real[:] x; 
  output Real[size(x,1)] y; 
protected 
  Real t; 
algorithm 
  y := x; 
  for i in 1:size(x,1) loop 
    for j in 1:size(x,1) loop 
      if y[i] > y[j] then 
       t := y[i]; 
       y[i] := y[j]; 
       y[j] := t; 
      end if;  
    end for; 
  end for; 
end bubblesort; 

It is also possible to enter a function directly into the 
session handler. 

>> function MySqr input Real x; output 
Real y; algorithm y:=x*x; end MySqr; 
Ok 

And then call the function: 
>> b:=MySqr(2) 
4.0 

Another built-in command is cd, the change current 
directory command. The resulting current directory is 
returned as a string. 

>> cd("..")  
"/home/petfr/modelica" 

We load a model, here the whole Modelica standard 
library: 

>> loadModel(Modelica) 
true 

We also load a file containing the dcmotor model: 

>> 
loadFile("C:/OpenModelica1.4.0/testmodels 
/dcmotor.mo") 
true 

It is simulated: 

>> simulate(dcmotor,startTime=0.0, 
stopTime=10.0) 

record 
    resultFile = "dcmotor_res.plt" 
end record 

We list the source  code of the model: 

>> list(dcmotor) 
"model dcmotor 
Modelica.Electrical.Analog.Basic.Resistor 
r1(R=10); 
Modelica.Electrical.Analog.Basic.Inductor 
i1; 
Modelica.Electrical.Analog.Basic.EMF emf1; 
Modelica.Mechanics.Rotational.Inertia 
load; 
Modelica.Electrical.Analog.Basic.Ground g; 
Modelica.Electrical.Analog.Sources.Constan
tVoltage v; 
equation  
  connect(v.p,r1.p); 
  connect(v.n,g.p); 
  connect(r1.n,i1.p); 
  connect(i1.n,emf1.p); 
  connect(emf1.n,g.p); 
  connect(emf1.flange_b,load.flange_a); 
end dcmotor; 

We plot part of the simulated result: 

>> plot({load.w,load.phi}) 
true 

The output is shown in Fig. 6. 
 

 
Fig. 6.  Plot of the simulated dcmotor model. 

Clear all loaded libraries and models: 

>> clear() 
true 

List the loaded models – but nothing left: 

>> list() 
"" 
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We load another model, the Influenza model: 

>> 
loadFile("M:/modeq/VC7/Setup/testmodels/ 
Influenza.mo") 
true 

It is simulated: 

>> simulate(Influenza,startTime=0.0, 
stopTime=3.0) 
record 
    resultFile = "Influenza_res.plt" 
end record 

The simulated population is plotted, which is shown in 
Fig. 7. 

>> plot({Infected_Popul.p}) 
true 
 

 
Fig. 7.  Plot of the Influenza model. 

For a complete list of the available commands, see 
[13]. 

6 DrModelica Notebook and Textual 
Model Editor 

The OpenModelica electronic notebook (OMNote-
book) and model editor subsystem [1] [8] can be used 
as a textual modeling interface for Modelica, or as a 
Modelica tutoring system, i.e., a simplified version of 
the earlier Mathematica-based DrModelica tutoring 
system for teaching Modelica. 

The simplified OpenModelica electronic notebooks are 
however able to handle the full DrModelica tutorial 
material, containing most of the Modelica examples in 
[10]. It is advanced enough to represent hierarchical 
documents, simple type setting, text editing, graphic 
cells, etc.  

 
Fig. 8.  The start page (main page) of DrModelica in the 

OpenModelica notebook system. 

This is exemplified by Fig. 8, showing the DrModelica 
main page (start page) in the teaching material. 

6.1 Some OpenModelica Notebook Commands 

The current prototype of OpenModelica notebooks 
includes, but is not limited, to the following opera-
tions: 

• Opening and closing groups of cells by double 
clicking the hierarchical tree view (to the right). 

• Evaluation of Modelica code, commands, and ex-
pressions in input cells by typing SHIFT+RETURN. 
The evaluation results are shown in a created out-
put cell. 

• Opening loading, and saving notebook files in 
XML (.onb) format.  

• Terminating the notebook subsystem (ALT+Q or 
ALT+F4). 

• Select a cell, by a single click on the cell in the tree 
view to the right. 

• Possibility to edit the style template to change the 
appearance of different cell types. 

• Move cursor, by CTRL + UP ARROW or CTRL + 
DOWN ARROW. 

• Close current document (CTRL+W). 
• Select and copy text inside a cell. 

7 Modelica Algorithmic Subset Debug-
ger 

This section presents a comprehensive Modelica de-
bugger [18] for an extended algorithmic subset of the 
Modelica language. The debugger replaces debugging 
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of algorithmic code using primitive means such as 
print statements or asserts which is complex, time-
consuming and error- prone.  

Two versions of the debugger has been developed. The 
first version, [18], is based on Emacs as user interface. 
The second more recent and substantially improved 
version is integrated in Eclipse as part of the Open-
Modelica MDT Eclipse plugin, and is being released at 
the time of this writing. Some aspects of this new de-
bugger are described in [19]. 

The debugger is portable since it is based on transpar-
ent source code instrumentation techniques that are 
independent of the implementation platform. 

The usual debugging functionality found in debuggers 
for procedural or traditional object-oriented languages 
is supported, such as setting and removing break-
points, single-stepping, inspecting variables, back-
trace of stack contents, tracing, etc.  

In this section we present parts of the Emacs version of 
the debugger functionality. Some of the functionality 
of the Emacs version of the debugger is shown Fig. 9.  

7.1 Debugger Commands 

The Emacs Modelica debug mode is implemented as a 
specialization of the Grand Unified Debugger (GUD) 
interface (gud-mode) from Emacs. Because the Mode-
lica debug mode is based on the GUD interface, some 
of the commands have the same familiar key bindings.  

The actual commands sent to the debugger are also 
presented together with GUD commands preceded by 
the Modelica debugger prompt: mdb@>.  

If the debugger commands have several alternatives 
these are presented using the notation:  

alternative1|alternative2|....   

The optional command components are presented us-
ing notation: [optional]. 

In the Emacs interface: M-x stands for holding down 
the Meta key (mapped to Alt in general) and pressing 
the key after the dash, here x,  C-x stands for holding 
down the Control (Ctrl) key and pressing x, 
<RET> is equivalent to pressing the Enter key, and 
<SPC> to pressing the Space key. 

7.2 Starting the Modelica Debugging Subprocess 

The command for starting the Modelica debugger un-
der Emacs is the following: 

M-x modelicadebug <RET> executable 
<RET> 

7.3 Setting/Deleting Breakpoints 

A part of a session using this type of commands is 
shown in Fig. 9 below.  

 
Fig. 9.  Using breakpoints. 

This is only a brief presentation of a subset of the de-
bugger functionality. See the OpenModelica Users 
Guide [13] for a more complete description. 

8 Modelica Development Tooling (MDT) 
Eclipse Plug-In 

The Modelica Development Tooling (MDT) Eclipse 
Plugin [21] integrates the OpenModelica compiler 
with Eclipse. MDT, together with the OpenModelica 
compiler, provides an environment for working with 
Modelica development projects. 

The following features are available: 

• Browsing support for Modelica projects, packages, 
and classes 

• Wizards for creating Modelica projects, packages, 
and classes 

• Syntax color highlighting 
• Syntax checking 
• Code completion 
• Automatic indentation 
• Automatic display of information about declared 

items 
• Browsing of Modelica modules and libraries 

8.1 Using the Modelica Perspective 

The most convenient way to work with Modelica pro-
jects is to use to the Modelica perspective. To switch 
to the Modelica perspective, choose the Window menu 
item, pick Open Perspective followed by 
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Other... Select the Modelica option from the dia-
log presented and click OK. 

8.2 Creating a Project 

To start a new project, use the New Modelica Pro-
ject Wizard. It is accessible through File->New-> 
Modelica Project or by right-clicking in the Mode-
lica Projects view and selecting New->Modelica 
Project. 

8.3 Creating a Package 

To create a new package inside a Modelica project, 
select File->New->Modelica Package. Enter the 
desired name of the package and a description of what 
it contains. 

 
Fig. 10.  Creating a new package. 

8.4 Creating a Class 

To create a new Modelica class, select where in the 
hierarchy that you want to add your new class and 
select File->New->Modelica Class. When creat-
ing a Modelica class you can add different restrictions 
on what the class can contain. These can for example 
be model, connector, block, record, or func-
tion.  

 
Fig. 11.  Creating a new class. 

When you have selected your desired class type, you 
can select modifiers that add code blocks to the gener-
ated code. ‘Include initial code block’ will for 
example add the line ‘initial equation’ to the 
class. 

8.5 Syntax Checking 

Whenever a Modelica (.mo) file is saved by the Mode-
lica Editor, it is checked for syntactical errors. Any 
errors that are found are added to the Problems view 
and also marked in the source code editor. Errors are 
marked in the editor as a red circle with a white cross, 
a squiggly red line under the problematic construct, 
and as a red marker in the right-hand side of the editor. 
If you want to reach the problem, you can either click 
the item in the Problems view or select the red box in 
the right-hand side of the editor. 

 
Fig. 12.  Syntax checking. 

9 Graphic Editing with MathModelica 
Lite 

A model can be built using the graphical model editor 
by using drag-and-drop of already developed and 
freely available model components from the Modelica 
Standard Library. 

The Modelica Standard Library can be loaded into the 
OpenModelica environment when the MathModelica 
Lite model editor is started and can be browsed using 
the class browser visible at the left of  Fig. 13 below. 

This section just gives a short sample of using the 
graphical model editor. See www.mathcore.com for 
the complete MathModelica System Designer User’s 
Guide, which includes additional capabilities in mod-
eling, simulation, plotting, and Modelica library sup-
port. 

As mentioned previously, there is no graphical model 
editor in OpenModelica, but the Lite edition of the 
MathModelica model editor from MathCore that 
works together with OpenModelica can be 
downloaded from the OpenModelica web site or di-
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rectly from www.mathcore.com/products/math-
modelica/lite/. The Lite edition of the editor is 
free for academic non-commercial usage. 

 
Fig. 13.  The model editor of MathModelica Lite with the 

class browser to the left, the graphic editing area in the 
middle, and the instance component browser to the right. 

10 Conclusion 
We have presented some aspects of the OpenModelica 
environment, including facilities for modeling, simula-
tion, and debugging Modelica code. A number of ob-
jectives of the OpenModelica environment have been 
presented and some examples illustrated. It has been 
demonstrated that the OpenModelica environment 
includes many valuable features for engineers and re-
searchers, and it is the only Modelica environment so 
far with good support for debugging Modelica algo-
rithmic code as well as support for meta-programming 
integrated in the language. We believe that this open 
source platform can be part of forming the foundation 
of the next generation of the Modelica language and 
environment development efforts, both from a research 
perspective and a system engineering usage point of 
view. 
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